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ABOUT THIS GUIDE  

This guide gives instructions for loading the Tinytag Explorer software program on to a 
personal computer (PC), and the basic setup of a data logger. 
 
When you have installed the system, use the Help file of Tinytag Explorer to obtain 
full instructions on operating Tinytag Explorer and the data loggers. 

WHAT YOU NEED 

Before installing Tinytag Explorer, check that you have the following equipment: 
 

• Tinytag Explorer CD. 

• Software activation code. 

• One or more data loggers. 

• Download cable or inductive pad for connecting the data loggers to the PC. 

• External probe (only for data loggers that use a probe). 

  
The activation code for Tinytag Explorer is printed on the back of the CD box. Do 
not lose or destroy the activation code. 
 

If any equipment is missing, please contact your Tinytag distributor. 

OTHER MANUALS AND GUIDES  

Versions of manuals and guides in other languages are available at 
www.tinytag.info. 
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INSTALL T INYTAG EXPLORER ON A  PC  

Tinytag Explorer must be installed on the PC that you intend to use to download the 
information collected by the data loggers. 
 
1. Start the PC. 
2. Insert the Tinytag Explorer CDROM into the CD drive of the PC. 

The Windows installer wizard should open after a few seconds. If it does not: 
1. Open Windows Explorer and navigate to your CDROM drive. The drive is 

usually labelled CD-RW Drive, DVD/CD-RW Drive or Compact Disk.  
2. Open the CD and find the setup.exe file (if you can’t find it, look for 

tinytag.msi). 
3. Double-click on setup.exe (or tinytag.msi): the installation should now 

start. 
3. When the installer wizard opens, click Next. Then follow the on-screen 

instructions. 
4. Read the Licence Agreement, then click Accept. 
5. At the Select Installation Folder dialog box, accept the default choice then click 

Next. 
6. At the Ready to Install dialog box, click Install. 
7. At the Finished dialog box, click Finish. 

 

PC firewall 
 
If the PC is equipped with a firewall program, a warning message may appear during 
the installation of Tinytag Explorer. Simply instruct the firewall to always allow this 
connection. 



4 

 

ACTIVATE T INYTAG EXPLORER 

1. Click the Windows Start button. 

2. At the Start Menu, click Programs or All Programs, then choose Tinytag 

Explorer from the pop-up menu. 

Tinytag Explorer launches and the Main Window opens. Then the Activate 
Tinytag Explorer dialog box opens. 

3. When prompted, type the activation code into the blank field of the dialog box. 

4. Click Confirm Code to activate Tinytag Explorer. If the program does not 

activate, please contact your Tinytag distributor. 

CHOOSE A  COM PORT 

The com (communications) port is the PC socket to which data loggers are 
connected. Most PCs have more than one com port - so you must tell the PC which 
port to use. 

 

If you are using a USB cable or inductive pad, you should follow the instructions 
in the Tinytag USB User Guide (supplied with the device) to install it and to 
determine which communications port it has been assigned. 

 

1. At the Tinytag Explorer Main Window, click the Options menu and choose 

Communications Options. 

2. When the Communications Options dialog box opens, click the tick box beside 
each port that you want to use. Leave the other tick boxes unchecked. 
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3. Click OK to close the Communications Options dialog box. 
If you have selected more than one com port, a drop-down menu appears on the 
toolbar of the Tinytag Explorer Main Window. The menu lists all the available com 
ports. 

 

4. Choose the desired port. 
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CONNECT A  DATA LOGGER 

Each Tinytag data logger has a download cable for connection to the PC. Several 
different cables are available, depending on the type of logger you are using. 

1. The PC end of the download cable can terminate in 9-pin D-type plug or a USB 
plug. 

2. The logger end of the cable can terminate in a 3-pin plug or a 3.5 mm jack plug. 

3. Some types of data logger use an inductive pad. The PC end of the pad cable 
terminates in a 9-pin D-type socket or a USB plug. 

 

Connecting a D-type download cable to the PC 

 

1. Make sure that the 9-way, D-type plug is the right way up 
with respect to the socket at the back of the PC. Then push 
the plug firmly into the socket. 

2. Tighten the two fixing screws until the D-type plug is 
secure. Do not over-tighten the screws.  

 

Connecting a USB cable to the PC  

 

1. Insert the USB plug into the USB port of the PC. The USB 
plug only fits in one way, so do not force the plug into the 
port. 
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Connecting an inductive pad 
 
The cable of a Tinytag inductive pad terminates in a D-type plug or a USB plug and 
connects to the PC as described above.  
Do not position the pad on top of electrical equipment such as a PC or monitor, or on 
metal surfaces. This will disrupt communications between the pad and the data logger 
 

Connecting a 3-pin download cable to the data logger 
 
Some types of data logger have a weatherproof cap that protects the connection 
socket. Remove the cap before connecting the download cable. 
 
1. Align the locating slot on the cable plug with the 

corresponding key in the data logger’s socket and push 
home firmly. 

 
 
 

Connecting a jack plug to the data logger  

 
1. Remove the lid from the logger. 
2. Carefully insert the jack plug into the jack socket of the data 

logger until the plug clicks into place.  
 
 
 
 

Connecting the data logger to an inductive pad 
 
1. To connect the data logger, just place the logger in the centre of the pad. 
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CONFIGURE A  DATA LOGGER 

 

1. With the data logger connected (or positioned correctly on its inductive pad), 
select the correct com port as described on pages 4 and 5. 

2. In the Logger menu, choose Launch, or click       on the toolbar. 

 

Enter a description 

 

When the Erase, Configure and Launch dialog box opens, click the      expand icon  in 

the Description panel. 

Click in the text field and type a suitable description for the logger or measurement. 

Set the logging interval 

 

The logging interval is the time that elapses between recorded measurements. This 
parameter must be set, otherwise you cannot launch the data logger. There are two 
logging interval modes: 

 

Seconds Mode is used for short intervals where readings may fluctuate rapidly. 
In this mode, you cannot take maximum and minimum readings or download data 
while the logger is recording. 

If the data logger has already been used, download and save the data in the logger 
before you launch it, otherwise the previously recorded data will be lost. See page 
15. 
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Minutes Mode, the desired logging interval must be in multiples of one minute. In 
this mode you can check the current reading of the data logger at any time, take 
maximum and minimum readings, and download data while the logger is running.  

 
Setting the logging interval in Seconds 
1. Click the expand icon      in the Logging Interval panel. Then click Seconds 

Mode. 
2. Click in the hours, minutes and seconds text boxes and type the total duration of 

the logging interval, or use the arrows in each box. 

Setting the logging interval in Minutes 
1. Click the expand icon      in the Logging Interval panel. Then click Minutes 

Mode. 
2. Click in the days, hours and minutes text boxes and type the total duration of the 

logging interval, or use the arrows in each box. 
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Set the starting options 

There are two starting options - Relative start time and Absolute start time. They 
are alternatives - by default the logger will start immediately if these settings are not 
changed. See Tinytag Explorer Help. 
 

Setting a relative start time 

1. Click the expand icon      in the Starting Options panel. Then click Relative start 

time. 

2. Click in the days, hours and minutes text boxes and type the time at which you 
want logging to start, relative to the present date and time, or use the arrows in 
each box. 

 

 

 

 

 

Setting an absolute start time 

1. Click the expand icon      in the Starting Options panel. Then click Absolute 

start time. 

2. Click in the left text field and type the day, month and year on which you want 
logging to start, or use the arrows in the box to set the date. 

3. Click in the right text field and type the hours and minutes at which you want 
logging to start, or use the arrows in the box to set the time. 

 

 

 

 

 

 

Starting a logger immediately 

To start a logger immediately, choose Relative start time and set the day, hours and 

minutes to zero (0). 
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Triggered start 
Some data loggers are triggered by passing a magnet close to the logger or pressing 
a switch. This is a special feature that does not apply to all types of logger. When the 
option is available, the Relative start time parameter includes a Wait until trigger 
event tick box. 
 

To select a triggered start: 
 

1. Click the Wait until trigger event tick box. 
2. If desired, set a delay period as described in Setting a relative start time. The 

delay starts from the time at which the logger is triggered by the magnet. 
 

Select the measurements option 
There are three measurements options: 

• Condition measured at the end of each interval - an instantaneous value 

measured at the end of each logging interval, also known as a spot 
measurement. 

• Minimum Condition during each interval - the lowest value measured during 

each logging interval. 

• Maximum Condition during each interval - the highest value measured during 

each logging interval. 
 

Some types of data logger support the spot measurement option only. Other types of 
logger support all three measurement options. 
 

1. Click the expand icon      in the Measurements panel. 
2. Choose the measurement option(s) that you want to use. If supported, you can 

choose all three options or any combination of them. 
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Set the stop option 

There are three ways of stopping a recording session automatically: 

• Run indefinitely - the logger records continuously, taking readings until its 

memory is full and then overwriting old readings.  

• Stop after N readings - the logger takes a set number of readings and then 

stops. 

• Stop when full - the logger takes readings until its memory is full and then stops. 

1. Click the expand icon      in the Stop Options panel. 

2. Choose the stop option that you want to use. If you select the Stop after N 
readings option, click in the text box and type the required number of readings, or 
use the arrows to select the number. 

Set the alarm options 

Some types of data logger have an alarm feature which sets a visual indicator on the 
logger if a reading above or below a preset alarm limit is detected. There are four 
alarm types: 
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• Above - an alarm is indicated only whilst the measured value exceeds the value 

entered. When the measured value falls below the entered value, the alarm will 
switch off. 

• Below - an alarm is indicated only whilst the measured value is below the value 

entered. When the measured value exceeds the entered value, the alarm will 
switch off. 

• Latching Above - an alarm is indicated when the measured value exceeds the 

value entered. When the measured value falls below the entered value, the alarm 
remains on until it is reset by the user. 

• Latching Below - an alarm is indicated when the measured value falls below the 

value entered. When the measured value exceeds the entered value, the alarm 
remains on until it is reset by the user. 

 
Setting the alarm options 
1. Click the expand icon      in the Alarm Options panel. 
2. Click one of the Enabled tick boxes. 
3. Choose a condition from the Property menu. The menu options are determined 

by the type of logger in use. 
4. Choose an Alarm Type as described in Set the alarm options above. 
5. Click in the Level text box and type the level at which you want the alarm to be 

triggered - or use the arrows to select the level. 
Tinytag Explorer automatically rounds the alarm level up or down to match the 
resolution of the logger in use. 

6. Repeat steps 2 to 5 to set another alarm level. 

You can now launch the data logger. 
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LAUNCH THE DATA  LOGGER 

1. Click Launch on the Erase, Configure and Launch dialog box. 
2. When the Launch Confirmation dialog box opens, check that the information in 

the Settings Summary is correct. 
 
 
 
 
 
 
  
 
 
 
 
 
 

 
If a setting is incorrect and you want to change it, you must stop the logging 
session and configure the data logger again. 
 

3. To enter notes about the data logger and/or the logging session, click in the 
Comments text field and type your comment. 

4. To print the configuration settings summary, click Print. Then click OK. 
5. Disconnect the data logger from the PC and place it in the area to be monitored. 
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DOWNLOAD DATA FROM A  LOGGER 

When a data logger has recorded sufficient information, you connect it to the PC and 
download the data. 
1. Connect the data logger to the PC and, if necessary, choose a com port in 

Tinytag Explorer. See pages 4 and 5. 
2. In the Logger menu, choose Get Data, or click       on the toolbar. 
3. The downloaded data is displayed in Graph View. 
 

If the logging interval of the data logger is set to Seconds mode, the logger 
cannot download data while still running. In this event, you are prompted to stop 
the recording process before downloading the data. 

SAVE DATA FROM A LOGGER 

We recommend that, when you have downloaded the data from your logger, you 
should save the data. Data can be saved to the hard disk of a PC, to a network folder, 
or to removable media. We recommend that you create a folder specifically for your 
saved data. 
 
1. In the File menu, choose Save, or click       on the toolbar. 
2. Navigate to the folder in which you save your data logger files. 
3. In the File name field, type a suitable name for the new data file. 
4. Click Save. 
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STOP A  DATA LOGGER 

You can stop a launched data logger at any time. If the logging interval is set to 

Seconds mode, you must stop the logger before you can download data. 

1. Connect the data logger to the PC and, if necessary, choose a com port in 
Tinytag Explorer. See pages 4 and 5. 

2. In the Logger menu, choose Stop, or click       on the toolbar. 

3. When the confirmation message opens, click OK. 

FURTHER INFORMATION 

For further information on using Tinytag Explorer - including more details about the 
instructions in this Quick Start Guide - please see Tinytag Explorer’s Help file. To view 

this: 

1. At the Tinytag Explorer Main Window, click the Help menu and choose Contents. 

2. Choose a topic and follow the instructions. 

If you have any questions that are not covered in the Help file, contact your distributor 

or: 
 

Gemini Data Loggers (UK) Ltd. 

Scientific House, Terminus Road,  

Chichester, West Sussex, 

PO19 8UJ  England. 

www.tinytag.info 
 

Sales   Technical Support 

t: +44 (0)1243 813000 t: +44 (0)1243 813009 

f: +44 (0)1243 531948 f: +44 (0)1243 531948 

e: sales@tinytag.info e: help@tinytag.info 
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